Policy Analysis for the Kaibab Plateau (and Introduction to Vensim)

The year is 1920.

You are the game manager of the Kaibab Plateau, a region of about 800,000 acres on the north side of the Grand Canyon. You are charged with maintaining the environmental balance of the region. In particular, you must take steps to control the deer population, which has grown alarmingly since the elimination of predators began around 1900.

Pressure groups and lobbyists have been calling your office daily with pet policies they want you to adopt.

- The Sierra Club argues that the elimination of the predators caused the problem, so reintroduction of the mountain lions, coyotes, and other predators will solve it.
- The ranchers, worried about their herds, are dead set against any reintroduction of predators.
- The local hunters want free access to the plateau.

Worse, the governor has let it be known that unless you come up with an effective policy to control the deer, you'll be looking for a new job.

Since there has never been a deer population explosion like this before, experience cannot guide you in your quest for effective policies. Fortunately, you have retained some expensive consultants from the University at Albany (paid for with government money, of course). The consultants have built some sort of model of the plateau. They claim you can use the model to test the impact of different policy proposals on the herd. You are skeptical, but have little choice. The consultants' model is contained on your class files disk as KAIBAB. A description of what actually happened on the plateau appears in the Appendix.

(0) Call up Vensim PLE, and open the KAIBAB.MDL model on the disk handed out in class.
[In the "Open" dialog box, type *.mdl and press return (or click OK) to see all the files labeled ".mdl", or just type KAIBAB.MDL as the file to open.]

You should see a screen like the one on the next page.
Scroll around to look at the whole model. To see the entire model at once, use the View menu to Zoom to a different magnification -- 50% will let you see almost all at once here. Investigate the pull-down menus. Note in particular the entries in the Model menu. Look at the Time Bounds. Over what years will the simulation run? How much simulated time elapses between successive computations?

(1) a) **Print the Vensim diagram of the KAIBAB model.** It should print nicely in "landscape" mode, with one sector to a page. If the page break lines on the screen do not look like landscape mode, go to Print Options in the File menu, and click on Best Choice or Landscape Always; click OK, you should be back at the model diagram.

b) **Draw a single, connected causal-loop diagram of the KAIBAB model.** Identify the stocks (levels) by drawing rectangles around them, but leave the rest in simple words and arrows. Read the following before you begin.

You can begin the connected causal-loop diagram by drawing the variables as they appear on the screen, substituting words and arrows for the flow symbols and their labels. But the model is divided into sectors and some variables (the ones that look like <Food>) are brought in from other sectors. That might make it hard to see all the loops. But Vensim can help create the causal-loop diagram.

Try this procedure: Double click on the Deer level to select it (it should appear in the window bar as the variable on Vensim's "workbench.") Then click on the loop symbol in the vertical bar of tools on the left of your screen (see "Loops" on the Vensim screen picture on page 2). You will see a list of loops increasing in "length" (number of other variables around the loop). Start with the loop of length 1 and draw it: In the middle of a sheet of paper write Deer and Deer Net Increase and connect them with arrows in a loop. Draw a box around Deer to show it's a stock or level variable. Then add to your picture the words and arrows of the next loop that Vensim lists. Proceed until you have all the loops that involve Deer. Then double click on Predators to select it on the workbench, click on loops, and add those (very few) new loops to your diagram. Finally, do the same for the remaining level Food. If your diagram is messy, you could redraw it for clarity, but don't spend a lot of time on this.

Identify the polarities of links and loops in your diagram. There are two loops that switch between positive and negative polarity -- which are those? There is only one other positive loop -- what is it?

(2) a) **Base Run.** Next to the "runner" button in the menu bar of buttons across the top, there is a window in which you can name each simulation.
Erase the name that is in there and type the word BASE (upper or lower case, it doesn't matter), to be the name of the base run of the KAIBAB model. Then click on the "runner" button (not the SET button) to simulate the model.

You will see Time go by, and you will see a window with some warnings about being "above" or "in" some of the graphical variables in the model. You can ignore these warnings at this point -- click on the "close" box in the upper left corner of this warnings window to close it.

Click on the "dial" button at the right-end of the menu bar of buttons (shown above) to bring up the Control Panel. Click on the word "Graphs" if it is not selected. In the list of saved graphs, double click on KAIBAB POPULATIONS to show a graph of Deer, Predators, and Food. Click on KAIBAB RATIOS to see some other information in the system. (Or click once and select Display.)

Other Graphs

Looking at the model diagram, you can show graphs of anything in the model by double clicking on the variable you are interested in (to put it on the Vensim's "workbench") and selecting any of the Graph tools in the tool bar at the left of the screen. Try it: double click on a variable such as Food Per Deer Ratio and then select the Causes Graph tool, and then the Single Graph tool. The Causes Graph should look like the figure at the right.

If you see a variable in the strip graph that you'd like to investigate, double click on its name in the strip graph and select the same strip graph tool to see that variable and its causes or effects displayed. Note that the Causes Graph tool shows you a graph of the variable on the Workbench, followed by all the variables that directly influence that variable. You can thus trace causal effects graphically. So investigate.
In the written report you hand in discuss briefly the following: Compare the plots to the actual behavior of the system described and shown in the Appendix. Can we use this model to test policies to avoid a collapse of the deer herd?

You can print a custom graph or strip graph to hand in by clicking on the little printer symbol in the window bar of the graph window. You can also, or instead, copy a custom graph or a strip graph to paste into a word processing document: click on the little clipboard symbol in the window bar of the graph you want to copy. Move to the window of your word processor and paste in the graph as you wish. Before you print or copy you can resize any of the graphs by clicking and dragging a corner.

For what you hand in, I would suggest that you copy graphs and paste them into a word processing document (as I have have done here) so that you can talk about them as well as show them.

(3) Policy analysis: Reintroduction of predators. The Predator harvest fraction in Predator Sector of the model represents the fraction of the predator population that ranchers and hunters are eliminating every year. The fraction is given as a function of time, with points marked every five years from 1900 to 1950:

![Graph Lookup - Fraction harvest p yr f](image)

The graph represents the idea the bounty offered in 1905 led within five years to enough hunting activity to eliminate 20% of the predator population every year from 1910 on.

(a) We will simulate the policy of removing the bounty in 1920 and bringing hunting on the Plateau to a halt by 1925.
Scroll around in the model to view the entire Predator Sector. Then in the top menu bar, click on the SET button (a runner getting ready to run). Some of the word phrases will become blue, indicating you can select them to change their values. Click on "Fraction harvest p yr f"; you will see the window shown above containing a graph over time of the fraction of predators we're assuming are being harvested each year because of the bounty placed upon predators.

In the table of values at the left, change the 1925 value from 0.2 to 0. Continue for 1930, 1935 and so on to 1950. You should see the graph change accordingly. [You can also change these points in the graph itself by moving points with the mouse, but it's hard to be precise.] When you are done, click OK. Then name the run ReintroA or some other suitable name (in the menu bar) and click on the Run (runner) button.

Click on the Dial button to see the Custom Graphs, but before viewing them we have to make the new graphs the active ones. Click on Datasets, and then click once on ReintroA to bring it to the top of the list. Then click on Graphs and select the graph(s) you want to see.

Looking at the model diagram you can select variables to view in *comparative* graphs. Double click on Deer, for example, and then click on the Single Graph button (on the left). You should see a graph that shows the deer population in both the Base and ReintroA simulations. You might do this for each of the stocks in the model, and anything else you think might be interesting to look at in this comparative way.

The Causes Graph tool works the same way here, showing you the two simulation runs together.

In your written report discuss what happens in this policy. Why does it happen?

(b) Suppose the ranchers delay the implementation of this policy five years. Try the same kind of simulation with the zero harvest fraction starting five years later (1930). Be sure to rename your new simulation, say ReintroB.

Are the results predictable?

(c) Try another hunting policy of your own devising. Note that the first five numbers in the Predator hunting fraction table must be 0/0/.2/.2/.2 because these are the history that you are dealing with up to 1920, after which you can take some different action.

Hand in a graph of your run [ReintroC? ReintroC1, ReintroC2?], and comment on it (see the comments above about printing or cutting and pasting a graph).

What can you say about policies for reintroducing predators? Do they solve the problem?

To get ready for more simulation runs, it would probably be a good idea to remove the Reintro datasets so they don't show up in future graphs. Click on the Dial button to see the Control Panel, and click on the Datasets tab. Click once on the name of a dataset you want to
remove (say ReintroA) and then click on the button marked <<. That will "unload" that dataset -- it will still be available (in the list on the left), but only the "loaded" graphs show up in graphs. Leave the Base run loaded so you can use it for comparative purposes. Of course, as you go on you can control the datasets that are loaded so you can show any comparisons you'd like.

(4) Policy analysis: Harvesting deer. Hunters have urged the hunting of deer to maintain a healthy herd and prevent the collapse. We will test three "harvesting" policies: a constant number of deer per year; a constant fraction of the deer per year; and a harvest whenever the deer population exceeds a chosen target.

To test these we have to edit the model. Click anywhere on the model diagram to make it the active window. Add a new outflow rate from the deer population called the Deer harvest rate.

(Click on the flow tool, click once inside the Deer level, move the mouse up out of the level about an inch (where you want the end of the flow pipe to be) and click the mouse button again. You'll be given a box to name the flow: call it Deer Harvest Rate. If you don't like what you have you can adjust it somewhat by clicking and dragging the cloud or the circle "handles" that appear, or you can erase it with the Pac Man tool (eat it up) and try again.)

The sequence should look like

Click inside the Deer box, then move the mouse about an inch above. It should look like this:

![Diagram](https://via.placeholder.com/150)

Click the mouse at that point and you get:
Fill in the name for the flow -- the Deer Harvest Rate -- and press Return and you should see:

This next step is important: Hold down the Ctrl key and the Shift key simultaneously and click on the Deer level -- you will see and equation-writing screen for the initial value of Deer and the flows into and out of the Deer level. Add (that is, subtract) the new outflow Deer Harvest Rate, then click OK.

We will set the Deer Harvest Rate equal to the sum of three new auxiliary variables: DHR1, DHR2, and DHR3. There's not enough room for them in the Deer Sector diagram, however, so we will put them in a new sector, labeled the Deer Harvest Sector, which will be a fourth page of your model diagram, and link them to the Deer Sector.

The picture you are about to add looks like this:
Here's how to create it:

Click on the auxiliary variable tool, and click somewhere in the Deer Harvest Sector page of your model. Name the new variable DHR. Then click three more times nearby to create the variables DHR1, DHR2, and DHR3. To set DHR equal to these, click on the information link tool and click on DHR1 and DHR in succession to make a link from DHR1 to DHR. Similarly make links from DHR2 and DHR3 to DHR.

To write the equation for DHR, hold down the Shift key and the Ctrl key simultaneously and click on DHR. You will see the equation writing screen for DHR. Set it equal to DHR1 + DHR2 + DHR3 (you can just click on the names and put plus signs in between -- you don't have to retype the variables here). Make the units deer/year and click OK.

Use these techniques to set DHR1 equal to

(\text{Constant deer harvest})*(\text{STEP}(1, \text{Deer harvest year})).

[First create in the diagram the variables for Constant Deer Harvest and Deer Harvest Year. Then Ctrl-Shift click DHR1 to write the equation. The STEP is a built-in function: you can enter it by just typing its name. Make sure the parentheses match.]

To set DHR2 equal to \((\text{Deer harvest frac})*(\text{Deer})*(\text{STEP}(1, \text{Deer harvest year}))\) we must add the Deer level to the Deer Harvest Sector as a "shadow" variable, a copy of the variable defined in the Deer Sector. Select the Shadow variable tool and click near DHR2 and DHR3; from the list of variables that appears select Deer and click OK. You will have added \(<\text{Deer}>\) to your diagram.

Following the procedures above, set DHR2 equal to

\((\text{Deer harvest frac})*(\text{Deer})*(\text{STEP}(1, \text{Deer harvest year}))\)

and DHR3 equal to

\(\text{MAX}(0, (\text{Deer} - \text{Desired deer pop})/(\text{Time to correct DP}))*\text{STEP}(1,\text{Deer harvest year}).\)

In the process, you'll need to add some more auxiliary variables to your diagram for the various constants in these equations. Use Ctrl-Shift-click to set the values of those constants initially as follows:
Deer harvest year = 1920  [units = year]
Constant deer harvest = 0   [units = deer/year]
Deer harvest frac = 0     [units = 1/year]
Desired deer pop = 1e6    [units = deer]
Time to correct DP = 1     [units = year]

When you are done the Deer Harvest Sector will look something like the following (the geometry may be very different in your picture, but the connections and variables should be the same):
One last important step: We need to link your DHR variable to the Deer Harvest Rate you created in the Deer Sector. Go back to the Deer Sector. Click on the "shadow variable" button to select it, and then click somewhere near the Deer Harvest Rate (about an inch away would be good). Up will come a window asking you which variable you want to place there as a shadow variable. Find DHR, select it, and click OK. You should see <DHR> placed on the screen. Select the arrow tool and link DHR to the Deer Harvest Rate. Then control-shift click on the Deer Harvest Rate and set it equal to DHR.

You have now created all the necessary changes and the model should run with the new sector present.

To be sure every equation has been specified, you can click on the equations tool at the top of your screen. Any unspecified variables will show up black. Click on these (you don't need to Ctrl-Shift click since the equation writing tool is selected) and fix them. You can also go to the Model menu and select Check Model. You hope it comes up "Model is A.O.K." If not, fix the error(s) that Check Model identifies.

When you are done, you might want to look at all the equations in the model --click on the Document Model tool at the left of the screen (see page 3). You should see your new equations, just as you want them. Save your model!

Note that the parameters are set so that the policies are all initially inactive. You will change these constants in reruns to test the policies. If you run the model in this condition, it should behave exactly as before, since the new deer harvesting structures are not active. Try it: Run your model, giving the run the name DHR0. The strip graphs or the single graph tool will show both runs, so you can easily compare. If DHR0 behaves differently from the Base run, go back over your changes to fix them until the model behaves just as before. Don't continue unless it does. Call if necessary.

Save your model. Print out a model diagram (click in the diagram to make it the active window and select Print from the File menu). Print out an equation listing by clicking on the Document Model tool in the tool bar on the left of your screen and clicking on the little printer icon in the window bar of the model listing. [Alternatively, click on the Clipboard symbol (which copies all the equations onto the clipboard, and go to a word processor document and Paste.)] Hand in a model diagram and an equation listing with your new equations highlighted somehow.

(5) Deer harvest policy 1.

(a) Sketch a word and arrow diagram of the deer population and the deer harvesting rate given by policy DHR1. (Leave out the rest of the model; note there is no feedback loop in this policy, as you should see if you double click on DHR1 and select the loops tool.)
(b) Simulate the deer harvesting policy 1 by clicking on the SET button and clicking on the Constant Deer Harvest parameter. Set its new value to 1000. Name the run DHR1, and click on the Run (runner button) to simulate. Check the resulting predefined custom graph (and any strip graphs you like), and print any you decide you want to include in what you hand in.

Then try enough other values for the constant number of deer harvested per year, to get a good idea of what this policy is likely to do. [Always change the constant using the SET button rather than by editing the model itself! Changes made like this always revert back to the original model after the run.] Judge whether DHR1 is a good or bad policy.

Summarize your results (please include an illustrative plot for this exercise and the remaining exercises).

(6) Deer harvest policy 2.

(a) Draw a word and arrow diagram of the deer population and the structure of the deer harvesting policy 2. (Note that there is a feedback loop here, as you should see if you double click on DHR2 and select the loops tool. Is it positive or negative?)

(b) Simulate policy 2 by changing the fraction of deer harvested per year from zero to 0.1. [Change the constant by clicking on the SET button and on the constant, as before.]

Try other values of the fraction of deer harvested per year until you are satisfied you understand the effects of this policy. Summarize your results.

(7) Deer harvest policy 3.

(a) Draw a word and arrow diagram of the deer population and the structure of the third deer harvesting policy. (The loops tool may help. Note there is a feedback loop here. Is it positive or negative?)

(b) The article in the Appendix suggests that 30000 would be a sustainable size for the deer herd. Simulate policy 3, trying a Desired deer population equal to 30000.

Then try 35000. What happens? Why? Try other values of the Desired deer population if you wish.

---

1 Remember: If you want to look at or print strip graphs that show only some of the runs, you can remove the datasets you do not want to see by clicking on the Dial button and going to the Control Panel. If you click on a loaded dataset you want to remove, it will become selected and move to the top of the list; clicking on the >> symbol will remove that dataset from the active list. Now call up a graph, and it should display only the datasets you want.
Then try Desired deer population = 30000 with the Deer harvest year to 1926, simulating implementation of the 30000 deer limit in 1926 instead of 1920. [You will have to change two constants in SET mode.] What happens? What do you learn about the real world from this simulation?

Summarize your findings about this third policy.

(8) **Policy recommendations.**

What policy would you recommend to the governor? Why?

A serious question, to be answered as thoughtfully as time and energy permit: How would you actually *implement* your policy recommendation?
Prior to 1907, the deer herd on the Kaibab Plateau, which consists of some 727,000 acres and is on the north side of the Grand Canyon in Arizona, numbered about 4,000. In 1907, a bounty was placed on cougars, wolves, and coyotes—all natural predators of deer. Within 15 to 20 years, there was a substantial extirpation of these predators (over 8,000) and a consequent and immediate irruption of the deer population. By 1918, the deer population had increased more than tenfold; the evident overbrowsing of the area brought the first of a series of warnings by competent investigators, none of which produced a much needed quick change in either the bounty policy or that deal with deer removal. In the absence of predation by its natural predators (cougars, wolves, coyotes) or by man as a hunter, the herd reached 100,000 in 1924; in the absence of sufficient food, 60 percent of the herd died off in two successive winters. By then, the girdling of so much of the vegetation through browsing precluded recovery of the food reserve to such an extent that subsequent die-off and reduced natality yielded a population about half that which could theoretically have been previously maintained. Perhaps the most pertinent statement relative to the matter of the interregulatory effect of predator and prey is the following by Aldo Leopold, one of the most significant of recent figures on the conservation scene:

We have found no record of a deer irruption in North America antedating the removal of deer predators. Those parts of the continent which still retain the native predators have reported no irruptions. This circumstantial evidence supports the surmise that removal of predators predisposes a deer herd to irruptive behavior.